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FBLA-PBL Format 

(including special software 
program to learn state abbreviations) 



 

 

CREATING BUSINESS LETTERS  
 

Business letters represent the organization you work for. Spelling errors, poor grammar, or 
poor formatting (letter construction) reflect badly on your company. Large and prosperous 
companies have the money to hire competent people who can spell and organize their thoughts 
well. They write good business letters. Companies like to do business with prosperous compa-
nies because of the impression that if they are large and prosperous they must have a good 
product and be doing well. What kind of impression, then, do you think is made when a letter is 
sloppy, has spelling errors, etc.?  
 

When you complete this unit, you will be able to: 
 
x� Create Block style letters following the FBLA-PBL Format Guide 
x� Change Line Spacing 
x� Show Vertical and Horizontal Rulers on a document 
x� Set Font Styles and Font Sizes 
x� Create a Block Style Personal Letter 
x� Use Open punctuation 
x� Spell Check Your Document 
x� Use Headers 
x� Create new folders and save documents 
x� Create a Block Style Business Letter 
x� Use Advanced Letter Features—Mailing Notation, Attention Line, Subject Line, Second 

Page Heading, Company Name, Enclosure Notation, Copy Notation, and Postscript 
x� Use numbered and bulleted paragraphs 
x� Practice writing skills by creating letters 
x� Use Letterhead from the Microsoft Office templates 
x� Insert Clip Art into the Letterhead 
x� Resize clip art and text boxes 
x� Use the correct official USPS State and US Possession abbreviations 

�� Practice the State/Possession abbreviation quiz on the special software provided by 
Ellsworth Publishing Company until you can take the quiz with 100% accuracy. 

 

Objectives 
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General Guidelines 
 
Font Size: 12 
 
Font Style: Times, Times New Roman, or Arial 
 
Spacing: 1 or 2 spaces after punctuation ending a sentence (stay consistent within the 
  Document 
 
  1 space after a semicolon 
  1 space after a comma 
  1 or 2 spaces after a colon (stay consistent within the document) 
  1 space between state abbreviation and ZIP 
 
Line Spacing: Single spacing  
 
Letters: Block Style (all lines begin at the Left Margin) with Open Punctuation 
  Top Margin:  2 inches 
  Side and Bottom Margins:  1 inch 

This is the example.  
Don’t type from this;  
directions begin on the 
next page. 
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LETTER - PERSONAL 
  Top Margin:    2” 
Side Margins:    1” 



 Open a Blank Word Document 
 
x� Click on Start 
x� Rest pointer on All Programs 
x� Rest pointer on Microsoft Office 
x� Click on Microsoft Office Word 

2007 

Set Line Spacing to 1.0 
 
When you first open a Word 2007 
document, it has some default (pre-
set) settings. You need set your line 
spacing to 1.0 with no extra space 
after paragraphs. 
 
x� Click on the Line Spacing button. 
x� Click on the 1.0 setting for single 

spacing. 
x� Click on the Line Spacing button 

to open it again. 
x� Click Remove Space After Para-

graph (if necessary). 

Line Spacing Button 

Show Vertical and Horizontal Rulers 
 
It is helpful to see the vertical and horizontal rulers to measure and line up objects in a docu-
ment, and to set tabs. 

 
 x� Click the View tab. 

x� Click Ruler box (if it does not 
already have a check mark). 

 

You should see a horizontal ruler, see below, on the top part of your document screen. You 
will also see a vertical ruler down the left part of your document screen. 

Personal & Business Letters 2007-2011 Ellsworth Publishing Co. 
www.EllsworthPublishing.com 
©  PBL  4 



 

 

Set Font Styles, Font Sizes, and 2” Top Margin 
 
Letters have 1” right and left margins, which are default margins (pre-set by Microsoft when 
you first open a Word document). You can see the 1” left margin in the shaded area of the hori-
zontal ruler below.  

The top margin of a letter should be 2”. Notice in the vertical ruler 
to the right that there is a 1” default top margin. So, in order to start 
keying at 2”, you must press the enter key four or five times until 
your cursor looks to be about even with the 1” on the vertical ruler. 
(The 1” default margin + spacing down 1” = 2”.) 
 
x� Click on the Home tab. 
 

x� Select the Times New Roman font style and 12 font size. 
 

x� Press the Enter key about 4 or 5 times. Does it look even with 
the 1” mark on the vertical ruler? 

1” default 
margin 

Begin keying 
here for a 
2” top 
margin. 

Vertical Ruler 

Create a Block Style Personal Letter, Assignment #PBL-1 

 
 
 
 

Current Date 
 
 
 
Mr. David Miller 
2814 E. Watkins Rd. 
Phoenix, AZ 85066 
 
Dear Mr. Miller 

4 

2 

4 

2 

Press Enter 4-5 times to leave 1 more inch from the top margin. 

Press Enter 2 times to double space to the Salutation (Dear Mr. Miller). 

Press Enter 4 times to Inside Address—who you are sending the letter to. 

Press Enter 2 times to double space to the body of the letter. 
 

NOTICE: There is NO colon after the Salutation. This is 
called OPEN PUNCTUATION. 
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My husband and I are building a home in the mountains. We have been looking around for Soap-
stone stoves. I understand you carry this line. I know they are very expensive, but I understand 
that ACE Hardware has a sale in June. Our house is not yet completed so we can wait for the sale 
to purchase the stove. Since we have a few months to wait for the sale, I wanted to have you put 
away a Soapstone stove and consider it sold. I am willing to put a down payment on it to secure it. 
 
I will be in the store next Monday to put a down payment on the stove. 
 
Sincerely 
 
 
 
Barbara Smith 
3200 E. Galveston St. 
Chandler, AZ 85224 

2 

4 NOTICE: There is NO comma after the Closing line (Sincerely). Open punctuation contains 
NOTHING after the Salutation or Closing line.  
 

Press Enter 4 times to the typed signature. This allows enough space for a written signature. 
 

. 

The Personal style letter contains personal information after the typed signature. 

Spell Check Your Document 
 

x� As you look at your document, misspellings are often indicated by 
a red wavy line under the word. Right click on the word and the 
suggestions for the correct spelling are shown on the top of the pop 
up menu. Click on one of the words to replace the misspelled word 
in your document, or correct the misspelling on your own. 

 

x� To check the whole document, click on the Review tab, click on 
the Spelling & Grammar button and follow the prompts. 

x� Click on the Insert tab. Click the Header button. 
 

x� Select Blank (Three Columns). 
 

x� Click in the left placeholder [Type Text] and key your name, #PBL-1. 
 

x� Select the next placeholder and key in the current date. 
 

x� Select the last placeholder and depress the Delete key. 
 
x� Click on Close Header and Footer button. 

Enter your Name and Assignment #PBL-1, and Date in the Header 

There are NO reference initials (initials of the typist) because it is assumed the author is the typist. 
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Save Assignment #PBL-1   
(Ask your instructor which drive or folder to save in.) 

x� Click the Office Button. 
 

x� Click Save As: 
 

x� The Save in: box should show 
where you are saving the docu-
ment—to a USB drive, Drive A, 
or to your computer hard drive. 
Usually the My Documents 
folder on your computer’s hard 
drive shows first. Assume you 
want to save to a new folder in 
the My Documents folder. 

 

x� Click on the Create New Folder 
button. 

 

x� Name the New Folder: Home-
work—Letters 

 

x� Click OK 

Create New 
Folder button 

 

x� Enter as the File name: #PBL-1 
 

x� Click the Save button. 
 

Print Assignment #PBL-1 and Turn it in to your Teacher 

x� Click the Office button. Click Print 
 

x� Click OK. 
 

x� Close Document, or continue to open a new document. 
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If you are still in a Word document, you may obtain a new Word document 
quickly: 
 

x� Click the Office Button. Click on New. 
 

x� Click on Blank and recent. 
 

x� Click the Create button (bottom, right). 

Assignment #PBL-2, Personal Letter in Times New Roman, 12 

Use Open Punctuation, which has no punctuation after the Salutation or Closing lines. Create 
a 2” top margin. Don’t be concerned about where words are divided; your computer will divide 
them properly. Your lines may end differently than these. 
 
Use today’s date. Inside Address: Mr. Dean Staples, 2155 N. Main, Seattle, WA 98101. 
Dear Mr. Staples ¶ (New paragraph)  We have been a satisfied customer of yours for about 
eleven years. Mr. Gene Cook, one of your employees, came last week to clean our air ducts. 
We looked at the main duct upstairs and it was still full of dust. The downstairs air return duct 
was not cleaned. ¶ We already paid for this service, as you can see by the enclosed paid bill. 
We feel we deserve better service than this and respectfully request that you call us to set up 
another cleaning appointment. ¶ Sincerely yours ¶ Marvin Goodman ¶ 1968 N. 3rd Street  ¶ 
Seattle, WA 98101 ¶  (Double space after the state and zip) Enclosure: Paid bill 

Assignment #PBL-3 , Business Letter in Times New Roman, 12 

Put your Name, Assignment #PBL-2 and date in the header.  Close Header & Footer. 
Save as #PBL-2 in the Homework—Letters folder, and print. 

The Business Letter with Open Punctuation is very similar to the Personal Letter above. It is 
assumed that a business letter is written on letterhead stationery which contains company infor-
mation. The differences are: 

 
 x� Instead of personal information 

after the name in the Closing, 
enter the Title. 

  
x� Double space after the Title and 

enter the Reference Initials of 
the typist in lower case. If the 
first letter automatically capital-
izes, just select it and change it. 

 Sincerely 
 
 
 
 Lucille Whitmer 
 Claims Department 
 
 tl  (Trudy Lamb is the secretary for the Claims 
Department) 
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Create the following Business Letter which is patterned after the letter style used for FBLA-
PBL competition: 

 
 
 
 
 
 
 
 
Current Date 
 
 
 
Ms. Jayson Lewis 
2009 E. Galveston St. 
Tyler, TX 75703 
 
Dear Ms. Lewis 
 
This letter is keyed in block style with open punctuation. All lines, including the date, 
inside address, salutation, body of the letter, and closing begin at the left margin. A  
double space is left between all letter parts except before the inside address and the 
writer’s name, which has a quadruple space (4 returns). 
 
This letter style is to be used for FBLA-PBL competition. 
 
Sincerely 
 
 
 
Barbara Small 
Director of Education 
 
xx (Initials of the typist in lower case) 

2” top margin 

4 

Put your Name, Assignment #PBL-3 and date in the header. Save as #PBL-3 in the 
Homework—Letters folder, and print. 

4 
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Assignment #PBL-4, Business Letter in Arial, 12 

x� Check Line Spacing 
x� Change fonts to Arial, 12 
x� Enclosure is a double space below the reference initials 

Use today’s date. Inside Address:  Mr. and Mrs. Terry Glase, 2001 West Monroe St.,  Chan-
dler, AZ 85224 
Dear Mr. and Mrs. Glase 
Here’s a copy of your new brochure! ¶  Under separate cover I am sending you the 400 that 
you ordered. The four-color printing is beautiful. It was the right decision to use the Fall cover 
photo. The bright red leaves of the maple trees are breathtaking. This brochure will be very 
effective for you, I am sure. ¶ We look forward to working with you again. We will keep the 
printer’s copy in our current files for one year. ¶ 
Thank you ¶ Austin Burke ¶ Sales Manager ¶ Reference Initials: (Your initials) ¶ Enclosure: 
New brochure 

Put your Name, Assignment #PBL-4 and date in the header.  Close Header & Footer. 
Save as #PBL-4 in the Homework—Letters folder, and print. 

Assignment #PBL-5, Business Letter in Arial, 12 

x� Check Line Spacing 
x� Arial, 12, fonts 
x� Enclosure is a double space below the reference initials 
x� The copy notation “c Mr. Burns, Engineering Department” is a double space below the en-

closure. This informs the person who receives the letter that Mr. Burns has a copy and is 
aware of the information. 

Use today’s date. Inside Address: Mr. Charles Johansen, 215 E. Main, Mesa, AZ 85202. 
Dear Mr. Johansen ¶ As you requested yesterday over the telephone, I am enclosing the 
price sheet for repairing the wheels on your luggage. Thank you for e-mailing us a photo of 
the damage. It is very unusual for that type of break to occur. Usually it happens during bag-
gage handling at the airport when a piece of luggage falls off the conveyer belt. ¶ We are 
pleased that you enjoy the luggage and we are sure it will last a long time for you. ¶ 
Sincerely ¶ Lucille Whitmer ¶ Claims Department ¶ Reference Initials: (Your initials) ¶ Enclo-
sure: Price sheet  ¶ c Mr. Burns, Engineering Department. 

Put your Name, Assignment #PBL-5 and date in the header.  Close Header & Footer. 
Save as #PBL-5 in the Homework—Letters folder, and print. 
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Advanced Letter Features 

The following advanced letter features are from the latest FBLA-PBL Format Guide. Assign-
ment #PBL-6 and #PBL-7 will use these advanced features. 

Mailing Notation: A mailing notation is keyed a double space below the date in ALL 
CAPS followed by a double space before the inside address. 

Attention Line: An attention line is keyed as the first line of the inside address. 
When an attention line is used, the salutation is “Ladies and Gentle-
men”. 

Subject Line: A subject line should be keyed a double space below the salutation 
in ALL CAPS. The subject line begins at the left margin. The word 
“subject: or “re” are not used when keying the subject line. 

Second Page Heading: If a letter contains more than one page, key a heading at the top of 
each subsequent page. Key the first line of the inside address, page 
number, and date at the left margin beginning one inch from the top 
of the paper. Double space below the date before continuing the 
body of the letter. 
 
  Ms. Terra Green 
  Page 2 
  Current Date 

Company Name: Key the company name a double space below the complimentary 
close in ALL CAPS. Quadruple space to the writer’s name. 

Enclosure Notation: Place an enclosure (or attachment) notation a double space below 
the reference initials. If multiple enclosures are referred to in the 
letter, follow the word “enclosures” with a colon and list each en-
closure. 

Copy Notation: Use a lowercase “c” by the name of the person(s) to receive a copy. 
Place the copy notation a double space below the last line of the 
enclosure notation or the reference line if there is no enclosure. 

Postscript: A postscript should be keyed as the last line in the letter. It should 
be preceded by a double space and begin at the left margin. The ini-
tials “P.S.” should not be used. 
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Assignment #PBL-6. Create a Business Letter with Advanced Letter Features,  
Times New Roman, 12 

Current Date 
 
CONFIDENTIAL  
 
Attention FBLA-PBL Competitors 
FBLA-PBL, Inc. 
1912 Association Drive 
Reston, VA 20191-1591 
 
Ladies and Gentlemen 
 
LETTER FORMAT WITH ADVANCED FEATURES 
 
This letter illustrates the placement of all advanced letter parts as described in the enclosed 
packet. It also illustrates the block style letter with open punctuation. The block style letter with 
open punctuation is the easiest and fastest style to use. Because it is so easy to use, it has be-
come the most popular letter style. 
 
Please refer to this packet when keying a letter with these features in order to avoid making for-
matting errors. Remember, when you send out a letter it represents your company. A well-
written letter with no spelling errors leaves a favorable impression with clients. On the other 
hand, a letter with formatting errors and misspellings leaves the impression that the company 
can’t afford good secretaries and may not have a good product either. 
 
Sincerely 
 
FBLA-PBL, INC. 
 
 
 
Barbara Jones 
Director of Education 
 
xx  
 
Enclosure 
 
c Ms. Jean Buckley, President/CEO 
 
Good luck in your competition! 

Mailing notation—if none, press Enter key 4 times after the Date. 

Attention line—keyed as the first line of the inside address. 

When a non-specific attention line is used, the salutation is “Ladies and Gentlemen.” 

Key the company name a double space below the complimentary close 
in ALL CAPS. Press the Enter key 4 times to the keyed signature. 

A postscript (like a last thought) is the last 
line in a letter. The initials “P.S.” should 
not be used. 
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If a subject line is used, it is a double 
space below the salutation in ALL CAPS. 

Use your Reference Initials. 



 

Put your Name, Assignment #PBL-6 and date in the header.  Close Header & Footer. 
Save as #PBL-6 in the Homework—Letters folder, and print. 

Assignment #PBL-7, Times New Roman, 12. Create a 2-Page Business Letter 
with Advanced Letter Features, Numbered Paragraphs 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

Create the following 2-page letter following correct letter format. 

Use Current Date.  
Mailing Notation: CONFIDENTIAL.  
Attention Line: Scheduling Department.  
Inside Address: Westward Ho Movers,  
216 N. Sweetwater Rd., Tyler, TX 75701. 
Ladies and Gentlemen  
Subject: Move on August 20 for Walt and Mary Downs 
As I stated on the telephone to Mr. Richman, there were a number of problems with our 
move by Westward Ho: ¶ The packing sheets were changed to indicate scratches and 
dents that were not on the original sheets (see the two sets of sheets enclosed). ¶ There 
is a missing drawer that belongs to the antique credenza (see photo). ¶ The Chinese 
screen was somehow crushed, ruining the surface. ¶ The white brocade sofa has a num-
ber of stains that my cleaning consultant, Mr. Wayland Coils, says will not come out. ¶ 
One of the legs on the folding table was broken off in a way that repair is impossible. ¶ 
One of the boxes of glassware fell during transit and most was broken. ¶  Mr. Richman 
was told that these damages amount to over $12,000 (see the value, repair, and cleaning 
statements and estimates enclosed). I have also enclosed statements from two antique 
authorities who saw the items the day Westward Ho packed them and have since exam-
ined the damage. ¶ I have called several times and I feel that I am given the run around. 
I talked to several different people at your office, I have been put on hold for long peri-
ods of time and I eventually hung up a few times. I am becoming impatient with this 
kind of treatment. Your company has a good reputation for satisfied customers and I 
know that you will want to keep this reputation. I am looking forward to a satisfactory 
solution to this problem. ¶ Please fax me the damage claim form and I will immediately 
complete it and fax it back to you today. I’m sure you will agree that coming to an equi-
table settlement by October 15 will be an advantage to both of us. ¶ Thank you. ¶ Sin-
cerely ¶ FINANCIAL GROUP, INC. ¶ Mary Downs ¶ General Manager ¶ xx (use your 
reference initials) ¶ Enclosures ¶ c Mr. Joe Anderson, Attorney ¶ I hope you will take 
care of this promptly. 

x� Select the 2nd - 7th paragraph (beginning with 
“The packing sheets” and ending with “One of 
the boxes”) and number them by clicking on the 
Numbering Icon. 
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Second page:  Top Margin: 1”, Single 
spacing, Double space from date to body. 

Name of Addressee or Company 
Page 2 
Date 



 x� Block letters have all paragraphs beginning 
at the left margin. While the paragraphs are 
still selected, click on the Decrease Indent 
button to remove the indent and line up the 
numbered paragraphs at the left margin. 

 

x� Click anywhere outside the selected area to 
deselect. 

Put your Name, Assignment #PBL-7 and date in the header.  Close Header & Footer. 
Save as #PBL-7 in the Homework—Letters folder, and print. 

Assignment #PBL-8, Times New Roman, 12. Create a 2-Page Business Letter 
with Advanced Letter Features, Bulleted Paragraphs.  

Create the following business letter and follow correct letter format. 

Use Current Date. Mailing Notation: CONFIDENTIAL. Attention Line: Order Depart-
ment. Inside Address: Cool Daze Air Conditioning, 7639 West Jordan Villa, Salt Lake 
City, UT 84111. 
Ladies and Gentlemen  
Subject: Cool Daze Model 1755A, Serial No. 3745, Purchase Order #6654 
The air conditioner I ordered from Cool Daze on April 1 is not performing according to 
specifications (see purchase and delivery documents attached). After I called your 800 
number, your Mr. Wally Cranks came and inspected the unit. He determined the prob-
lem is an internal defective seal, and he recommended replacement with a new unit (see 
the copy of his report attached). ¶ When I called your office, Mr. William Chatter said 
you have no units in stock and don’t have any scheduled for production until fall. He 
said you do have several Model 3755A’s available at $500 more. Since the weather is 
already heating up, I suggest we settle this one of two ways: ¶ Cool Daze supply and in-
stall the Model 3755A at no additional cost, or ¶ You remove the air conditioner from 
our roof by May 1 and immediately refund our money.¶ Please respond by April 23.  ¶  
Thank you. ¶ Sincerely ¶ ARIZONA BINDERY ¶ Kim Brown ¶ Plant Supervisor ¶ dj ¶ 
Enclosures ¶ c Mr. Wally Cranks ¶ I look forward to hearing from you soon. 

x� Select the last two paragraphs begin-
ning with “Cool Daze” and “You re-
move”; bullet these paragraphs by 
clicking on the Bullet Icon. 
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 x� Block the bulleted paragraphs. While 
the paragraphs are still selected, click 
on the Decrease Indent button to re-
move the indent and line up the 
bulleted paragraphs at the left margin. 

 

x� Click anywhere outside the selected 
area to deselect. 

Put your Name, Assignment #PBL-8 and date in the header.  Close Header & Footer. 
Save as #PBL-8 in the Homework—Letters folder, and print. 

Assignment #PBL-9, Arial, 12. Practice Personal Letter Writing Skills  
 
Create a Block style appreciation letter to send to a friend, teacher, or your parents. 
 
x� Change fonts to Arial, 12. (Since this is probably going to be a very short letter, you might 

consider leaving the line spacing at 1.15. Remove Space After Paragraph. If it turns out to 
be longer, select all lines in the letter and change the line spacing to 1.0) 

x� Use current date 
x� Create the Inside Address 
x� Use an appropriate Salutation (Dear Friend, Dear Mom and Dad, etc.) 
x� Use open punctuation 
x� Subject line:  Thanks for all you have done for me! 
x� Include at least three or four short paragraphs telling them what you appreciate that they 

have done for you. How about actually sending it? 
x� Use Complimentary Closing of your choice (Yours truly, Love, Sincerely, Regards, etc.) 

Put your Name, Assignment #PBL-9 and date in the header.  Close Header & Footer. 
Save as #PBL-8 in the Homework—Letters folder, and print. (Remove the header and 
footer after printing if you are going to mail it.) 

Assignment #PBL-10, Arial, 12. Using the Internet to Locate FREE Letter-
head Templates—Practice Business Letter Writing Skills  
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There are several sites on the Internet that offer “Free Letterhead”. It takes some searching to 
find ones you can use that are truly “free”. Some sites offer free letterhead samples but cleverly 
lead you to purchase printing the letterhead in greater numbers. Internet sites change and some 
searching is required. There are a lot of very nice templates that are available. Here is a site and 
directions this author found for the example here. 
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Use a Microsoft Office letterhead template to create the following Block style business letter. 
 

x� Open the Microsoft Internet Explorer browser (Start, All Programs, Internet Explorer) 
x� In the Search Area of your browser screen, enter “Free Microsoft Word Letterhead” and 

press the Enter key. 

x� Several suggested sites appear. You may have to do some searching in several of the sug-
gested sites in order to find a template you like. The listing on the right are paid adver-
tisements of businesses that create letterheads.  For this example, the Free Letterhead 
Templates link was chosen. 

x� In the Categories section, select: Business Letterheads. You may make another selection 
if you wish.  

 
x� Next, select Business Letterhead with Dots. 
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x� Scroll down. Accept the Terms of Use.  Click on “Download Free Version (DOC) …” 

If it doesn’t download automatically, you may have to download it manually by clicking on the 
link “start the download manually”: 

x� It is recommended that you click the 
Save button. Watch where it is 
saved to, or direct it to save to your 
USB drive. 
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x� Select and type your information in the areas indicated. 

x� Change fonts size to 12 for your letter.  
 

x� Use current date 
 

x� Inside Address:  Mr. Samuel Baxter, Lawn Lover Co., 1213 North Gates Drive, Detroit, 
MI  48204 

 

x� Use an appropriate Salutation. 
 

x� Subject Line:  Lawn Care 
 

x� Describe in two long or three short paragraphs what you want done to the lawn, or yard. 
Ask for an estimation of costs, the date it can be done, if they haul the trash, etc. 

 

x� Use appropriate Complimentary Close 
 

x� Use your reference initials 

Insert tab, Header button, Edit Header. Enter your Name and Assignment #PBL-10, 
press the tab key and enter the current date.  Close Header & Footer. Save  in the 
Homework—Letters folder, and print. 
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Assignment #PBL-11, LEARN OFFICIAL UNITED STATES POSTAL SERVICE 
STATE ABBREVIATIONS 

 
 

Anyone who writes letters needs to know the Official USPS State Abbreviations for both the 
Inside Address on the letter and the Address on the envelope.  In this assignment, study the 
state abbreviations. When you think you know them, go to the online quiz to check your 
knowledge. You can take the online quiz as often as you need to in order to achieve 100%.  
These twenty State/Possession abbreviations are very easy to remember because they are the 
first two letters of the State/Possession: 

STATE/
POSSESSION 

ABBREVIATION 

Alabama AL 
Arkansas AR 
California CA 
Colorado CO 
Delaware DE 
Florida FL 
Guam GU 
Idaho ID 
Illinois IL 
Indiana IN 
Massachusetts MA 
Michigan MI 
Nebraska NE 
Ohio OH 
Oklahoma OK 
Oregon OR 
Utah UT 
Washington WA 
Wisconsin WI 
Wyoming WY 

The full abbreviation list of the United 
States Postal Service may be found at: 
 www.usps.com/ncsc/lookups/
usps_abbreviations.html. 
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Study these State/Possession abbreviations: 

 
STATE/POSSESSION ABBREVIATION 

Alaska AK 
American Samoa AS 
Arizona AZ 
Connecticut CT 
District of Columbia DC 
Georgia GA 
Hawaii HI 
Iowa IA 
Kansas KS 
Kentucky KY 
Louisiana LA 
Maine ME 
Marshall Islands MH 
Maryland MD 
Minnesota MN 
Mississippi MS 
Missouri MO 
Montana MT 

STATE/
POSSESSION 

ABBREVIATION 

Nevada NV 

New Hampshire NH 
New Jersey NJ 
New Mexico NM 
New York NY 
North Carolina NC 
North Dakota ND 
Pennsylvania PA 
Puerto Rico PR 
Rhode Island RI 
South Carolina SC 
South Dakota SD 
Tennessee TN 
Texas TX 
Vermont VT 
Virgin Islands VI 
Virginia VA 
West Virginia WV 

For Assignment #PBL-11, go to www.KeyboardingOnline.com. At Login/Password, en-
ter the word "demo" on both lines. Click on the link next to the Nuts ’n’ Bolts textbook 
and take the State/Possession abbreviation quiz. Take it several times—Try to beat 
your best scores. Can you beat the programmer's score below. He's good, so if you 
can beat him you are really good!  2-minutes, 100%, is average. Print from the 
browser, write Assignment #PBL-11 next to your name.  


